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Disclaimer 
This document is only valid for the system configuration stated on this page. If your 
system has a different configuration, contact Heidelberg Instruments Mikrotechnik 
GmbH for a document matching your configuration. 
Every effort has been made to ensure that the data given in this document is accurate. 
The contents in this document are subject to change without notice. Heidelberg 
Instruments Mikrotechnik GmbH makes no warranty or representation, either expressed 
or implied with respect to this document. In no event will Heidelberg Instruments be 
liable for any direct, indirect, special, incidental, or consequential damages resulting 
from any defects in this documentation. 
This document is copyrighted with all rights reserved. Under the copyright laws, this 
document may not be copied in whole or in part or reproduced in any other media 
without the express written permission of Heidelberg Instruments Mikrotechnik GmbH. 
Permitted copies must carry the same proprietary and copyright notices as were affixed 
to the original. This exception does not allow copies to be made for others, whether or 
not sold, but all the material purchased may be sold, given, or loaned to another person. 
Under the law, copying includes translation into another language. 
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The µMLA is a high-speed, maskless direct-writing lithography system. Direct writing 
technology has the advantage of increasing the effective throughput as well as cost 
savings. 
The system is developed to expose substrates with a photoresist coating. The system 
can process different substrate sizes. The system also provides pattern changes, 
distortion correction, and other software-driven corrections. 
The system is equipped with an integrated ejector, which is connected to the 
pneumatics system of the machine and which creates the vacuum for properly fixing the 
substrates. Optionally, an external vacuum pump can be connected if needed. 
The system is equipped with one exposure LED. The exposure LED is a 390 nm 
ultraviolet LED. For more information, see the Technical Data Sheet. 
The system can be upgraded with an additional exposure laser upon customer request. 
The MLA Menu control software implements a graphical user interface. The control 
software allows to control and monitor the system and to set up and execute the 
applications. 
The system is equipped with a pneumatic autofocus. The pneumatic autofocus uses 
compressed air to regulate the distance between the write head and the substrate. 
The system is equipped with an optical autofocus. The optical autofocus provides 
superior focus stability and enables the system to expose very small surfaces. The 
operator can switch between the autofocus modes to meet the individual requirements 
of the application. 
The system is equipped with the basic grayscale exposure mode. The basic grayscale 
exposure mode enables the system to write complex topographies for micro-optical 
components or other grayscale applications. The write beam intensity can be modulated 
in 128 levels to expose thick resists with grayscale layouts. For the definition of the 
grayscale layouts, the system uses the BMP format and the DXF format. 
The system is delivered with an antivibration table. The antivibration table reduces 
vibrations that can affect the exposure quality. Additionally, the antivibration table 
serves as user PC table. 
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1.1 About this guide 
Chapter 1: Introduction 

Provides general information about this guide and a list of related documents. 

Chapter 2: General safety information 
Contains important information about safety precautions and recommendations to 
operate the system safely, properly, and economically. 

Chapter 3: System 
Contains detailed, illustrated system descriptions and provides an overview of the 
system components. 

Chapter 4: Exposure Wizard 
Contains an overview of the exposure wizards of the µMLA control software. 

Chapter 5: Turn on/off the system 
Contains step-by-step instructions about how to start, stop, and power down the 
system. 

Chapter 6: Set up jobs 
Contains step-by-step instructions about how to set up and execute exposure jobs. 

Chapter 7: Utilities and Tools 
Contains an overview of the utilities and tools of the µMLA control software. 

Chapter 8: Advanced functions for staff users 
Contains an overview of the advanced functions accessible to the staff user group. 

Chapter 9: Troubleshooting 
Contains troubleshooting and an overview of important information your local 
Heidelberg Instruments Mikrotechnik Customer Service Center requires when 
providing assistance. 

Chapter 10: Operator Maintenance 
Contains information about maintenance tasks that can be performed by the 
operator. 

 

The illustrations, photos, and screenshots are exemplary pictures and can deviate from 
the delivered products. 
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1.2 Related documentation 
The user manual consists of several related parts addressing the system configuration, 
safe and correct operation, and other important topics. If you did not receive any of the 
following user manual parts or if you want to order a replacement, contact Heidelberg 
Instruments Mikrotechnik, Germany. 

Pre-installation guide 
This guide contains detailed information about the system requirements. Also, this 
guide provides information about the sizes and weights of the components as well 
as other information relevant for installing the system. 

Safety guide 
This guide contains information about potential hazards (health, physical, and 
environmental) of the system. This guide provides you with the information 
necessary to safely move in, install, operate, and maintain the system. 

Conversion software guide 
Manual for the HIMT conversion software used for data preparation and fractioning 

Design creation guide 
This guide contains general rules, specific restrictions, and best-practice 
recommendations for creating designs. Also, this guide lists the supported design 
formats. 

Technical datasheet 
This sheet contains the system specifications and summarizes the performance 
and other characteristics of the system. Also, this sheet lists the technical 
requirements of the system. 
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2.1 Intended use 
If not stated otherwise in the signed purchase contract, the intended use of Heidelberg 
Instruments lithography systems is exclusively to expose structures on photosensitive, 
non-flammable layers which are located on non-flammable substrates. These 
substrates must not exceed the specified maximum dimensions and must be free of 
damage such as scratches or cracks. 
Heidelberg Instruments lithography systems are intended only for professional use. The 
related user documentation is part of the product, and the user is under the obligation to 
read the documentation before using the product. 
Usage for other purposes than those stated in this section is prohibited. No liability is 
assumed by Heidelberg Instruments Mikrotechnik GmbH for damages caused by the 
usage of the system outside of its stated purpose. 
In addition to the intended use stated above, the following purposes of use are 
prohibited and defined as misuse: 
• Operation outside the operating conditions stated in the Technical Datasheet or the 

sales confirmation. 
• Operation with materials other than the approved materials. 
• Change of the factory settings by unauthorized persons. 
• Use of attachment parts other than those provided by Heidelberg Instruments 

Mikrotechnik GmbH. 
• Operation of the system in a potentially explosive environment or aggressive 

atmosphere. 

2.2 Limitations 
This section gives an overview of the limitations that must be considered when working 
with the system. 

2.2.1 SYSTEM BOUNDARIES 
This guide refers solely to the lithography system as well as any peripheral components 
provided by Heidelberg Instruments Mikrotechnik GmbH (e.g., robot handler, heat 
exchangers, transformers, vacuum pumps). 
It explicitly excludes the installations required at the facility to run the machine (e.g., 
electrical power, compressed air, vacuum, water). Responsibility for the safety of the 
installations lies within the system owner. 
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2.2.2 ACCESS RESTRICTIONS 
No untrained, under-age or person that has not read and understood the contents 
of this guide and any other relevant part of the user manual is allowed to operate 
the system. If instructions are not followed carefully, danger to personal health and 
damage to equipment can occur. 
At all times, follow all warnings and instructions given in this manual, system software, 
safety labels on the system, or by our engineers. 
The system may only be used for the lithographic exposures or measurement 
processes it was manufactured for, as stated in the descriptions of this manual and all 
related documentation (including purchase documents and acceptance report). Do not 
use damaged or broken substrates or substrates that may cause stray reflections of the 
writing beam. 

2.3 Notation 
This manual contains some safety warnings. To classify the degree of danger in each of 
these situations, this guide uses the conventions defined in ANSI Z535.6-2011: 

 DANGER  Indicates a hazardous situation that, if not avoided, will result in 
death or serious injury. 

 

 

 WARNING  Indicates a hazardous situation that, if not avoided, could result 
in death or serious injury. 

 

 

 CAUTION  Indicates a hazardous situation that, if not avoided, could result 
in minor or moderate injury. 

 

 

NOTICE  Used to address practices not related to personal injury. 
 

 

 

Additional terminology conventions used in this manual are: 
NOTE  

Gives advice or hints to help the user to find the best solutions for the task at hand. 
 

Also, in some parts of this user manual, general information is given using special 
symbols as wildcards. These wildcards stand for entries that depend on the specific 
application. The wildcards used in this manual are: 
 

<….>  The text between the angular brackets denotes which information is 
expected here. The brackets are part of the wildcard and do not occur in the 
final text. 

$ Each of these symbols stands for a single text character. 

# Each of these symbols stands for a single digit. 
 

The definitions left and right refer to the front of the machine. 
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LEFT FRONT RIGHT 

Fig. 1: Orientation sketch 
 

2.4 Precautions and safety 
To reduce the risk of serious injury to yourself and others, read and understand the 
safety instructions before installing, commissioning, operating, or maintaining the 
system. 
Make sure that everyone reads the safety instructions before working with or on the 
system. Also, consider the risks that may be present as a result of individual conditions. 
The system is designed to allow safe access to all areas where access is required 
during regular operation. Technical protective measures are implemented with 
protective devices, such as covers and interlocks. To minimize the residual risks, all 
lasers, LEDs, associated optics, and moving parts are enclosed within housings to 
protect operators from exposure to laser radiation, LED radiation, and dangerous 
movement or voltages. During exposures or stage movement, the cover lid can be 
opened. Opening the cover lid stops the laser or LED emission and prevents any stage 
movement. 
 

 DANGER  

Risk of severe injuries when opening housings or covers 
There is a risk of severe injuries from various sources if protective housings or covers 
are opened during operation. 
Do not open any housings or covers that can only be opened by using tools. 
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2.4.1 LED SAFETY 
The µMLA uses LEDs of class 2 (according to DIN EN-62471-2) as exposure light 
sources. Unprotected exposure to the unmodified beam of these LEDs is dangerous for 
the eye. Even scattered light can be dangerous. Therefore, the exposure optics of the 
system are enclosed in a separate interlocked housing. 
While the housing is closed, no LED light is emitted or accessible outside of the system, 
and the system has a safety classification corresponding to class 1. 
The specific LED classes involved in the safety classification of the µMLA are: 
Operation state Description of system state Relevant LED 

class* 
Required 
precautions  

• Job running, 
• Idle time 

System housing and optics covers 
closed 

1 None  

• Loading 
• Unloading 
• Operator 

maintenance  
• Service 

Cover lid open, exposure beam 
blocked by shutter, optics cover box 
closed 
Service: Housing panels and optics 
box panels might have to be opened, 
exposure beam accessible. 

2 Avoid 
exposure of 
the eyes 

Tab. 1: Systems LED safety classification and required precautions in specific operation states 

* This table only denotes the LED safety class that corresponds to the machine safety 
classification in the respective state and determines the required precautions. It does 
not represent a classification of the system as the underlying norms apply only to lasers. 
For more information about the LEDs utilized in your system, see the Technical 
Datasheet. 
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2.4.2 ELECTRICAL SAFETY 
The system is equipped with a 3-pin, 1-phase IEC-C14 connector (230 V). The current 
rating of the machine is up to 10 A. 
If the local power connectors differ, an appropriate adapter cable can be attached. If 
required, a transformer may be used to supply the machine with the correct phase 
voltage. 

 DANGER  

Electrical shock! 
Fatal electrical shock and/or severe burns can be caused by the system power supply 
voltage, any power supply to peripheral components, or the internal 230V power 
supplies. 
• Do not use the equipment if cables or plugs have been damaged. 
• Only plug the µMLA and its components into approved outlets with the correct 

ground. 
• Ensure that both voltage and frequency of a power source match the voltage and 

frequency stated on the equipment’s electrical label. 
• Not all power cords have the same current ratings. Household extension cords do 

not have overload protection and are not meant for use with sensitive electronic 
equipment. Do not use household extension cords for any component of the 
µMLA. 

• Do not remove any covers of the system apart from those explicitly stated in this 
manual. Open covers can make lethal voltages accessible. 

• Only Heidelberg Instruments service engineers should perform any tasks that 
include the removal of such a cover while the system is connected to power. 

 

2.4.3 OTHER SAFETY RISKS DURING OPERATION 
 

 WARNING  

Medical implant failure due to magnetic and electromagnetic fields! 
The functioning of medical implants (e.g. pacemakers) and other sensitive equipment 
may be disturbed by the fields of the stage's magnet rails if coming close to them. 
Tell bearers of medical implants to keep a minimum distance of 0.3m (12") from the 
magnets at all times. 

 

 WARNING  

Injuries / dangers (poisoning, flammability) by coolant additives! 
Depending on the cooling fluid selected by the customer, additional safety risks may 
apply. 
Before deciding on a coolant or doing any refilling, refer to the manufacturer manuals 
and the coolant / additives safety data sheets for further information. 
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2.4.4 INTERLOCK AND SERVICE MODE 
To protect the operator from hazards by laser light, LED light, or stage movement, an 
interlock circuit prevents stage movement and access to the exposure beams while the 
cover lid is open. The cover lid can be opened at any time. Opening the cover lid stops 
laser emission, LED emission, and prevents any stage movement. 
The interlock can be overridden only by a Heidelberg Instruments Mikrotechnik service 
engineer. In this state, the system has to be considered unsafe and the safety 
measures described in the Safety Guide for servicing periods have to be followed. 

2.4.5 EMERGENCY SHUT-OFF 
NOTICE  

Emergency shut-off can damage the system. 
The emergency shut-off can cause damage to electrical circuits and other critical 
components because power is interrupted without an orderly shutdown. 
Only use the emergency shut-off in the event of emergency or danger. To turn off the 
machine normally, put the machine to standby mode. For maintenance and servicing, 
orderly shut down the system. 

In the event of emergency or danger, unplug the power cable or turn the main switch to 
the OFF position. Then, turn the interlock key switch 90° counterclockwise. The 
interlock key switch stops LED emissions even if the interlock circuit is not interrupted. 
The main switch and the interlock key switch are located on the left side of the machine. 
By turning the main switch to the OFF position or unplugging the power cable, the 
machine is completely shut down. 
By turning the interlock key switch, LED emissions are stopped even if the machine is 
accidentally turned on again. 
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2.5 Safety labels 

 

Fig. 2: Safety labels at the front of the machine 
 

 
Fig. 3: Safety labels at the left side of the machine 
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Fig. 4: Safety labels at the rear of the machine 
 

 

Fig. 5: Safety labels at the top of the machine 
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Fig. 6: Type plate at the left side of the machine 
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The system consists of the following system components: 
• The main unit, which consists of the base, stage, and optics system. 
• The machine control inside the machine. 
• The electronics inside the machine. 

3.1 Front 

 
Fig. 7: Front of the machine 

1 Ventilation grilles 
2 Power LED 
3 Interlock Circuit LED 

4 Cover lid with safety interlock circuit 
5 Base system plate 
6 Height-adjustable feet 

At the front of the machine, you find the cover lid with the interlock circuit, the Interlock 
Circuit LED, and the Power LED. The Interlock Circuit LED indicates if the interlock 
circuit is interrupted. The Power LED indicates if the machine is supplied with power. 
The cover lid is not locked while the stage moves, or during the exposure process. If 
you open the cover lid during the exposure process, the interlock circuit stops laser 
emissions and prevents stage movement. 
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3.2 Rear 

 
Fig. 8: Rear of the machine 

1 Ventilation grille 
2 Power supply switch 
3 Coolant reservoir 
4 LED heat exchanger 
5 Compressed air regulator 
6 Compressed air inlet 

7 Ejector pressure regulator 
8 Ejector 
9 Manometer for autofocus 
10 USB Network connectors 
11 LAN Network connector 

At the bottom right of the machine, you find the power supply switch and the main unit 
power connector with the fuse. 
Next to the power supply switch, you find the coolant reservoir for the exposure LED. 
You need to refill the coolant every half year. 
Next to the coolant reservoir, you find the heat exchanger of the exposure LED coolant 
circuit. 
At the bottom center of the machine, you find the compressed air regulator for the chuck 
vacuum and the pneumatic autofocus. The compressed air regulator is equipped with a 
particle filter and a manometer. 
At the bottom left of the machine, you find the ejector. The ejector uses compressed air 
to create the chuck vacuum. 
Below the ejector, you find the ejector pressure regulator for the chuck vacuum. You 
can adjust the strength of the chuck vacuum with the pressure regulator. 
In the bottom right corner of the machine, you find the manometer for the compressed 
air of the autofocus. 
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Above the manometer for the compressed air of the autofocus, you find the network 
connector for LAN and the high-resolution camera. 
Next to the network connectors for LAN and the high-resolution camera, you find the 
USB network connector for the DMD, the overview camera, and the lens. 

3.3 Left 

 
Fig. 9: Left side of the machine 

1 Interlock key switch 
2 Main switch 

3 Interlock circuit override 
4 Ventilation grilles 

On the left side of the machine, you find the main switch and the interlock key switch. 
With the interlock key switch, you can stop laser emissions even if the interlock circuit is 
not interrupted. The interlock key switch only stops laser emissions but does not prevent 
stage movement. 
Next to the main switch, you find the interlock circuit override. Heidelberg Instruments 
Mikrotechnik service engineers can use the interlock circuit override to override the 
stage interlock. 



µMLA    
 

 
 

 

16 User Manual 

3.4 Interior 

 
Fig. 10: Interior of the machine 

1 Optics system 
2 Stage system 

3 Base system 

Inside the machine housing, you find the main unit. 
The main unit consists of the following components: 
• Base system 
• Stage system 
• Optics system 
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3.4.1 BASE SYSTEM 

 
Fig. 11: Interior of the machine – Base system 

1 Transportation lock 
2 Main unit plate 

3 Height-adjustable feet 

The base system consists of the main unit plate which is mounted on 4 height-
adjustable feet. The main unit plate is precision polished to provide uniform properties 
for the stage. Damages to these surfaces may degrade the patterning quality. 
At the front of the main unit plate, you find the transportation lock that you use to secure 
the stage when transporting the machine. 
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3.4.2 STAGE SYSTEM 

 
Fig. 12: Interior of the machine – Stage system 

1 Chuck 
2 Vacuum zone selection screws 

3 Vacuum switch 

The stage system is mounted on the main unit plate and is equipped with linear motors 
in both axes. They provide smooth and constant movement with low positioning errors. 
Air bearings support the movement in y-direction whereas the x-axis is equipped with 
roller bearings.  
On the stage, a chuck is fixed. The chuck has vacuum openings to create a vacuum 
that holds the substrate in place tightly. 
At the front of the stage, you find the vacuum zone selection screws. With the vacuum 
zone selection screws, you control which zones of the chuck vacuum are active. 
In the front left corner of the main unit plate, you find the switch that you use to switch 
on the chuck vacuum. 
The stage coordinate system is rotated by 90° clockwise (+90°). On the stage, the x-
axis directs from the back to the front and the y-axis directs from the left to the right. 
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Fig. 13: Stage coordinate system 

The rotation is relevant when you load substrates. Also, the rotation is relevant when 
you navigate via the camera image in the control software. In the camera image, the x-
axis directs from the left to the right and the y-axis directs from the bottom to the top. 

 
Fig. 14: Camera coordinate system 
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3.4.3 OPTICS SYSTEM 

 
Fig. 15: Interior of the machine – Optics system 

1 Exposure optics 2 Write head 

The optics system consists of the following components: 
• Exposure optics 
• Write head 

EXPOSURE OPTICS 
The exposure optics is located in a fully enclosed housing above the main unit plate. 
The exposure optics consists of the following components: 
• Exposure laser: 
 The optional exposure laser is characterized by high reliability, a long lifetime, and a 

low noise level. The laser light is emitted by the laser diodes, coupled in an optical 
fiber, and projected on the substrate. 

• Exposure LED: 
 The system is equipped with a water-cooled exposure LED. The light of the LED is 

projected on the Digital Mirror Device. 
• Digital Mirror Device (DMD): 
 The DMD is an electrical input and optical output micro-electric-mechanical system 

for spatial light modulation. The DMD modulates the write beam so that the laser (or 
LED) light projects and transfers a light pattern onto the positive or negative resist 
on the substrate surface. 
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• Optical elements: 
 Several optical elements guide the modulated write beam through the optics system 

before the write beam passes the write head and is projected onto the substrate. 
• Optics: 
 The optics project the light pattern onto the substrate. 
• Camera system: 
 With the camera system, you can inspect the substrate, perform layer alignments, 

and carry out high-precision measuring processes. You control the camera system 
by using the control software. 

The camera system consists of the following cameras: 
• High-resolution camera 
• Overview camera 
The high-resolution camera shows more detail than the overview camera, but it covers 
a much smaller area. You use the high-resolution camera to inspect structures on the 
substrate. 
The overview camera shows less detail than the high-resolution camera, but it covers a 
much larger area. You use the overview camera to find alignment marks on the 
substrate. Note that the overview camera does not cover the entire substrate area 
because of technical limitations. 
The field of view of the camera system depends on the camera and the write mode. 
The following table shows the field of view dimensions of the camera system for the 
different write modes: 
Camera type Write Mode I Write Mode II 

High-resolution camera 150 µm × 110 µm 384 µm × 288 µm 

Overview camera 13 mm × 10 mm 13 mm × 10 mm 

Tab. 2: Camera system – Field of view dimensions 

WRITE HEAD 
The write head is mounted at the bottom of the exposure optics housing. 
The write head contains the following elements: 
• Write lens: 
 The write lens is the last optical element in the exposure beam path before the 

beam leaves the optics system. 
• Pneumatic autofocus: 
 The pneumatic autofocus keeps the focal point of the write beam stable on the 

surface of the substrate. For probing the distance, compressed air passes through 
the write head. Then, pressure builds up between the write head and the substrate. 
The pressure is monitored by a pressure sensor. 
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• Optical autofocus: 
 The optical autofocus controls the position of the write lens with high precision. The 

optical autofocus is intended for applications that require high resolution. 

3.5 Machine control 
External supply System 

  System control electronics   User PC   

power →   power →     

       Conversion software   

       convertible design data   

       ↓   

       exposure data   

       ↓   

       Control software   

    status →  system status   

       system parameters   

    commands ←  alignment sequences   

    ↓   design positioning   

  power  control      

  ↓ ↑ ↓      

compressed dry air →  sensor data       

cooling water ↔ Main unit      

vacuum (optional) →         

          

Fig. 16: Machine control – System components and functions 
 

3.6 Electronics 
The electronics consist of the following components: 
• Central control unit 
• Stage controller 
• Power supply 
• System network switch 
• User PC 

3.6.1 CENTRAL CONTROL UNIT 
The central control unit controls the motors of the machine. The motors are used in 
various functions throughout the system, for example, to control the positions of the 
optical elements to the selected write modes. 
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The central control unit also controls the pneumatic autofocus system. The central 
control unit receives sensor data about the air pressure. According to the sensor data, 
the central control unit adjusts the air pressure for the pneumatic autofocus. 

3.6.2 STAGE CONTROLLER 
The stage controller controls the stage and monitors its position. Based on the received 
data, the stage controller coordinates and drives the stage. 
In addition, the stage controller generates the trigger signals, which control the data 
clock and the intensity level of the write beam and which control the Digital Mirror 
Device (DMD). In this way, the stage controller operates the exposure. 

3.6.3 POWER SUPPLY 
The power supply controls the power distribution for all components of the system. 
At the bottom left side of the machine, you find the main switch. 
At the bottom right at the rear of the machine, you find the power supply switch. 

3.6.4 SYSTEM NETWORK SWITCH 
The components of the system communicate via a dedicated, internal LAN (local area 
network). To enable communication between the components, all components are 
connected to the system network hub. To enable communication with the external 
facility network, the system supports dual networking. 

NOTICE  

Risk of malfunction and delay 
If you connect components that are not part of the system to the system network hub 
or if you connect the system network hub directly to the facility network, data 
processing, and command transfer can be disturbed, which can result in malfunction 
or delay. 
Do not connect any non-system components to the system network hub. 
Do not connect the system network hub directly to the facility network. 

 

3.6.5 CONVERSION PC 
The conversion PC is emulated on the user PC via VirtualBox. The conversion PC is 
running under the Linux operating system. On the conversion PC, the conversion 
software is installed. The conversion software converts the design data into the 
machine-specific format so that the design can be processed by the system. 
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Fig. 17: Conversion of design data and design processing 

The conversion software [A] converts input files into machine-readable design data. 
The design data is made available [1] to the control software [B]. The control software 
can access and load the design data on demand. In the control software, you can 
position the design on a map and configure the map settings for exposure. When you 
start the exposure, the control software sends [2] the required commands to the system 
control electronics [C]. The system control electronics controls [3] the main unit [D] 
during exposure. 

3.6.6 USER PC 
The user PC is running under the Windows operating system. The user PC provides the 
control software with a graphical user interface where you can control and monitor the 
system. With the control software, you can control and monitor the system. Also, you 
use the control software to edit, manage, and execute exposure, measurement, and 
alignment jobs. For the jobs, you can select the designs that are already converted by 
the conversion software. 
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Fig. 18: Control and data processing 

The control software [A] is connected via the system control electronics [B] with the 
main unit [C]. The main unit continuously sends [1] sensor data and status information 
which is forwarded [2] to the control software so that you can monitor the system. Via 
the control software, you can send [3] commands to control [4] the main unit. 
When you set up exposure jobs, the control software sends a request [5] to the 
conversion software [D] to access the converted design data [6]. Then, you can place 
the converted design in the exposure job and configure the exposure job. Then, you can 
start the exposure. After you started the exposure, the control software sends [3/4] the 
related commands to the main unit so that the application is executed. 
The user PC is set up as a gateway PC. If enabled and configured at your facility, other 
PCs can access remotely via LAN. 
 

3.7 Software 
The conversion software and the control software are essential for operating the 
machine. Other utility software may be preinstalled, such as PDF Reader software. 
On the desktop of the user PC, you usually find desktop shortcuts for the conversion 
software and the control software. You can use the desktop shortcuts as usual to start 
the software. If the desktop shortcuts are not available, you can use the Start menu to 
start the software. Also, you can create and manage desktop shortcuts as desired, as 
on every Windows PC. 
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3.7.1 CONVERSION SOFTWARE 
You use the conversion software to convert image files, such as CAD data or bitmap 
images, into the machine-specific format so that the design can be processed by the 
system. 
In the conversion software, you can import image files of the supported file formats to 
compile designs. For the designs, you can already set relevant preprocessing 
parameters. Finally, you convert the design for later use by the control software. 
The system uses the following conversion software: APP 

3.7.2 CONTROL SOFTWARE 
You use the control software to control and monitor the system. You can create, edit, 
manage, and execute exposure jobs, measurements, and alignments. You can use the 
converted design data to set up exposure jobs. Also, you can preconfigure recipes with 
custom settings for frequently used applications. To start and execute common 
applications, the control software offers wizards that guide you through the processes 
step by step. 
Administrators use the control software to create presets for shared application objects, 
to administer users and user access rights, and to check the status of the system 
devices. 
The system uses the following control software: MLA Menu 

3.7.3 TEAMVIEWER SOFTWARE 
The TeamViewer software is preinstalled. You can use the TeamViewer software to 
invite a Heidelberg Instruments Mikrotechnik service engineer to attend a remote 
service session. 
You can start the TeamViewer session by double-clicking the desktop shortcut or via 
the Start menu. When the software is started, navigate to the Remote Control tab of the 
main interface. There, you find your Team Viewer ID and your temporary password. 
With this information, you can allow a Heidelberg Instruments Mikrotechnik service 
engineer remote control. 
For more information, see the documentation of the manufacturer. 

NOTICE  

Do not update the factory-installed TeamViewer software 
Updating the TeamViewer software can cause compatibility issues. 
An update of the TeamViewer software should be performed only in consultation with 
the Heidelberg Instruments Mikrotechnik Customer Service. 
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3.7.4 ANYDESK SOFTWARE 
The AnyDesk software is preinstalled. You can use the AnyDesk software to invite a 
Heidelberg Instruments Mikrotechnik service engineer to attend a remote service 
session. 
You can start the AnyDesk session by double-clicking the desktop shortcut or via the 
Start menu. When the software is started, you find your AnyDesk ID in the AnyDesk 
window. With this information, you can invite a Heidelberg Instruments Mikrotechnik 
service engineer to a remote service session. 
For more information, see the documentation of the manufacturer. 

3.8 Activate/deactivate vacuum zones 
This chapter explains how to activate and deactivate the vacuum zones of the chuck 
vacuum. 

Perform the following steps to activate and deactivate vacuum zones: 
1. Switch off the vacuum with the vacuum switch. 
2. Check the positions of the vacuum zone selection screws. 

 

Fig. 19: Vacuum zone selection 

3. Activate the vacuum zones that are required for the current substrate size by 
opening the relevant vacuum zone selection screws. 

NOTE  

In the center of the chuck, you find 4 vacuum holes. These vacuum holes are always 
active when the chuck vacuum is switched on. 
If you use substrates smaller than 2 inches, make sure that the 4 vacuum holes in the 
center of the chuck are completely covered by the substrate. 
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4. Deactivate the vacuum zones that are not required for the current substrate size by 
closing the relevant vacuum zone selection screws. 

5. Switch on the vacuum with the vacuum switch. 

3.9 Use alignment pins 

3.9.1 POSITION ALIGNMENT PINS 
You can use alignment pins when loading the substrate. The alignment pins help you to 
place the substrate on the chuck correctly. The positioning of the alignment pins varies 
depending on the type and the size of the substrate. 
The following figure shows the correct positioning of the alignment pins for different 
substrate types and sizes. 

 

Fig. 20: Alignment pins positioning 
 

 

3.9.2 REMOVE ALIGNMENT PINS 
NOTICE  

Make sure to remove all alignment pins. 
Unremoved alignment pins can cause severe damage to the write head and other 
critical system components. 
Always remove all alignment pins from the chuck before starting the exposure 
process. 

NOTE  

The µMLA standard configuration supports substrates up to 5 inches in size. 
However, you can purchase an upgrade for the exposure area to support 6-inch 
substrates. 
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Due to the small size of the alignment pins, it is recommended to use the pin removal 
tool. 

 

Fig. 21: Pin removal tool 

1 Thread 2 Alignment pin 

Perform the following steps to remove alignment pins from the chuck: 
1. Take the pin removal tool. 
2. Screw the threaded end of the tool into the alignment pin on the chuck. 
 The tool is fixed inside the pin. 
3. Pull out the tool together with the pin. 
4. Unscrew the pin from the tool. 
5. Repeat step 1 to step 4 for all alignment pins. 
6. Make sure that no alignment pin is left on the chuck. 
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The µMLA control software offers a quick setup of exposures and alignments, aided by 
the Exposure Wizard. This intuitive user interface guides the operator through the steps 
of an exposure setup. To start the wizard, you only have to double-click the link icon. 

4.1 Exposure Wizard: Overview 
The Exposure Wizard has its own window. This window stays open throughout the 
whole configuration and exposure procedure. It contains the following main elements: 

 
Fig. 22: Exposure Wizard 

NOTE  

Note that the following section may describe features, options, or objects that require 
extended user rights. 
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MENU BAR  
The menu bar is located at the top of the window, offering a couple of menu utilities. 

INFO SECTION  
The info block gives information about the hardware condition and the progress or 
status of the current exposure setup.  

PANEL  
The panel is located below the info section. This panel changes according to the tasks 
that the system has to perform. For example, the figure above shows the Set Up panel. 
Inside the panel are buttons and frames. 

FRAME 
The panel contains frames, for example, the Layer frame, where you select the design 
file and other options. The frame has mandatory fields that have to be filled with values, 
and fields that can be filled optionally. The mandatory fields are highlighted in orange 
and turn green once a value has been entered. The optional fields are highlighted in 
green before and after the entry of values.  
Throughout this manual, you find instructions like "double-click Design". In this case, 
you are instructed to double-click the value field with the title Design, not the word 
Design. 

BUTTONS 

 
Fig. 23: Exposure Wizard - Buttons 

A click on these buttons usually opens another window where you can select items or 
set options. 

NAVIGATION BUTTONS 
At the bottom of the wizard window, you find navigation buttons, for example, Load 
Substrate or Continue. The functions and names of the buttons depend on the 
selected exposure mode. These buttons can stay disabled until certain tasks are 
finished. 

INFO BOX 
Every panel contains a yellow text box, giving information and instructions on the 
current task.  
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TAB SECTION 
A block with two tabs is located below the menu bar. In one tab (Exposure Setup), a 
tree view shows the procedure steps that the system has to execute. The other tab 
(Info) shows a list of startup messages. 
In the following section, you find detailed information about the Exposure Wizard 
elements. 

4.1.1 MENU BAR 

File  
Exit Terminate the wizard and close the window. 

Tools  
LED Measurement Measure the power of the LED in order to compare it with the value 

measured during the most recent calibration procedure. 

Initialize Stage Initialize the stage in case the hardware info shows that it is not 
initialized. 

Large Camera Defoc In Alignment Mode, the focus settings can be switched to larger 
camera defocus with a wider defocus range. 
This option is only available in Alignment Mode. 

Backup Back up your system files. 

Logging This option is required for HIMT Service only. Do not change the 
settings as long as no service engineer demands it. 

Beam Offset Measure and adjust the beam offset. 

User  
Change User Change the user type. 

Tab. 3: Menu Bar – Buttons 

4.1.2 TAB SECTION 

EXPOSURE SETUP TAB 

 
Fig. 24: Exposure Wizard – Exposure Setup tab 
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The Exposure Setup Tab shows a tree view of the steps to be completed with the 
wizard from job setup to exposure and unloading. It is a graphical representation of the 
sequence of panels that make up one exposure job. As a kind of panel map, it can be 
taken for orientation.  
The green rectangle shows the options available in the selected Exposure Mod. The 
green tick indicates that the task is done. 

INFO TAB 
The Info Tab shows a list of messages informing the user about recent exposures and 
the condition of the system after startup. 

 
Fig. 25: Exposure Wizard – Info tab 

EXPOSURE INFO 
By clicking Exposure Info, a table opens containing a list of exposure jobs recently 
done and their exposure data. The page features a search bar for easy retrieval of 
exposure information. 

 
Fig. 26: Exposure Wizard – Exposure Info 

STARTUP INFO 
The control system checks the communication between the electronics and the 
hardware components. A list gives an overview of the components and their functional 
status. All list items should be marked green. If there are items showing a red cross, call 

NOTE  

If the Hardware Info Section shows red, open the Info Tab and check the startup 
messages to locate the problem. 
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Heidelberg Instruments Service. If the stage shows a red cross, try to initialize the stage 
with Tools » Initialize Stage. 

 
Fig. 27: Exposure Wizard – Startup Info 

4.1.3 INFO SECTION 
The Info Section consists of four subsections: 
• Exposure Info 
• Alignment Info 
• Progress Info  
• Hardware Info 

EXPOSURE INFO 

 
Fig. 28: Info section – Exposure Info 

 

Object Description 
Job Name Shows the job name. 

The job name is a combination of the word job and the job number. 
You can edit the job name by double-clicking into the Job Name field 
in the Job frame. 
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No. Shows the auto-incrementing number of the job. 

Substrate Size [mm] shows the size of the substrate that is currently loaded. 

Design Name shows the name of the design that is currently loaded. 

Design Size [mm] Shows the size of the design. 

Design Type Shows if the design is a binary file. 

Dose [mJ/cm²] Shows the light intensity that is set for the exposure. 
The necessary intensity depends on the write mode. Also, the 
necessary intensity depends on the resist thickness and sensitivity. 
So, you must work out the necessary intensity by exposure series with 
varying intensity. 

Height Shows the thickness of the substrate. 

Layer Shows the layer that is currently being prepared for exposure. 

Mode Shows the exposure quality level chosen at conversion: 
• Quality: Exposes the substrate with maximum quality but 

increases the exposure time. 
• Fast: Exposes the substrate with lower quality but decreases the 

exposure time. 

Defoc Shows the defocus value that is selected for the current exposure. 
The defoc with a range between -10 to 10 allows fine-tuning of the 
exposure focus. This value can be adjusted before starting the design 
exposure. 

Tab. 4: Exposure Info – Display objects 

ALIGNMENT INFO 

 
Fig. 29: Info section –Alignment Info 

 

Frame Description 
Expose Cross 
Positions 

Shows the positions of the alignment crosses set during the setup of 
the layer previous to the layer with the design that is to be aligned. For 
instance, when setting up the First Exposure job the coordinates of the 
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exposure crosses for the next layer can be determined and exposed 
together with the First Exposure layer. 

Align Cross 
Positions 

Shows the positions of the alignment crosses taken from the template 
file. 

Tab. 5: Alignment Info – Frames 

PROGRESS INFO 
The Progress Info provides information about the progress of the exposure process. 

 
Fig. 30: Info section – Progress Info 

 

Object Description 
Exposure Status Shows the status of the exposure job. 

Design Number Shows the number of the design that is being exposed. 

Stripe Number Shows the size of the substrate that is currently loaded. 

Time [hh:mm] Shows the estimated exposure time. 

Remaining Time 
[hh:mm] 

Shows the remaining exposure time. 

Tab. 6: Progress Info – Display objects 
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HARDWARE INFO 
The Hardware Info shows information about the system status. 

 
Fig. 31: Info section – Hardware Info 

 

Object Description 
Refresh Refresh the display to the current data. 

Stage Position fields Show the x-coordinate and the y-coordinate of the current stage 
position. 

Tab. 7: Hardware Info – Display objects 
 

Frame Description 
Status  Shows the status of the system devices. 

If a parameter displays a red cross, click Refresh. If the status does 
not change, go to Info Tab » Status Messages and check for error 
messages. 

Numeric Values Shows numeric values for various system components. This 
information is only relevant for Heidelberg Instruments Mikrotechnik 
service engineers 

Tab. 8: Hardware Info – Frames 
 

4.2 Tooltips 
The wizard features tooltips. Tooltips are elements of a graphical user interface, but 
they are not static such as the menu bar or informative fields. The tooltip appears when 
the user hovers over an item in the GUI without clicking on it. It disappears when 
leaving the surrounding of the item o clicking on it.  
If one of the navigation buttons in the lower part of the wizard window is grayed out, it is 
not possible to proceed with the task. When hovering over the Proceed frame 
containing the navigation buttons, a tooltip informs about missing information that is 
required to fulfill the respective task. 
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Fig. 32: Exposure Wizard – Tooltip 

 

4.3 Substrate representation 
In the Menu panel, you find a simple graphical depiction of the substrate showing the 
design position on the substrate. The position of the camera is also displayed to indicate 
which part of the substrate is currently visible in the camera image. 

 
Fig. 33: Exposure Wizard – Substrate representation 

Depending on the substrate shape (round or rectangular), the menu offers two different 
substrate visualizations. On the substrate, the design position and size are displayed by 
a red rectangle. The field of view of the camera is depicted as a blue rectangle. 

 
Fig. 34: Substrate representation – Substrate visualization 

1 Field of view 2 Design 
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The horizontal and vertical measure lines indicate the real size of the substrate. The 
size of the design representation and the size of the camera are scaled in relation to 
these measure lines. 
To move the design to a certain position on the substrate, use the Control Panel. 
Alternatively, drag the camera rectangle to the desired location. The design follows 
when the camera position is set to zero by clicking Set zero in the Control Panel. 

4.4 Loading panels 
Loading panels are part of the wizard. For design loading, job loading and template 
loading (series, substrate, resists) the sheets for loading contain a list of existing items 
but it is also possible to set up new templates or save new designs.  
All loading panels are arranged in the same way. 

 
Fig. 35: Exposure Wizard – Loading panel 

1 Parameters frame 
2 Loading panel 

3 Edit frame 

4.4.1  
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4.4.2 LOAD FRAME 

 
Fig. 36: Loading Panel – Load frame 

 

Object Description 
Load Load the item that is selected in the Designs list. 

Cancel Cancel the loading procedure and return to the previous panel. 

Refresh Refresh the display to the current data. 

Tab. 9: Load Frame – Control objects 

4.4.3 SEARCH FRAME 

 
Fig. 37: Loading Panel – Search frame 

 

Object Description 
Search Enter an item name in the input field to narrow the list of displayed 

items. Then, click Search to start the search. 

Clear Clear the Search input field. 

Tab. 10: Search Frame – Control objects 

4.4.4 SHOW FRAME 

 

 
Fig. 38: Loading Panel – Show frame 

 

Object Description 
all Select this option to show all items in the Designs list. 

next Select this option to only show a certain number of items in the 
Designs list. You can set the number of items that you want to show 
in the input field next to the radio button. 

next (button) Show the selected items. 

show only Templates Select this option to only show templates in the Designs list. 

Tab. 11: Show Frame – Control objects 
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4.4.5 PARAMETERS FRAME 
You find the Parameters frame left of the Loading panel. In the Parameters frame, new 
templates can be created, or the existing ones can be changed. These tables are 
explained in the respective chapters where loading or template set up are described. 
The control and display objects of the frame are fitted to the context. So, the available 
control and display objects can vary. 

4.4.6 EDIT FRAME 

 
Fig. 39: Loading Panel – Edit frame 

 

Object Description 
New Add a new item to the Designs list. 

Edit Edit the item that is selected in the Designs list. 

Save Save your changes. 

Delete Delete the item that is selected in the Designs list. 

Tab. 12: Edit Frame – Control objects 

4.4.7 DESIGNS LIST 

 
Fig. 40: Loading Panel – Designs list 

The Designs list shows all designs available or the items that are saved as templates. 
All information and parameters are listed in the columns of the table. 
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• You find the interlock key switch and the main switch on the left side of the 
machine. 

 For more information, see "Left", page 15. 
• You find the power supply switch at the rear of the machine. 
 For more information, see "3.2 Rear", page 14. 

NOTICE  

Updates of driver software can disrupt system stability! 
Whenever Windows offers updates, only select important updates. 
Never change the settings for automatic updates to fully automatic. 
Do not select updates of device drivers, for example, video and network 

5.1 Turn on the system 
• If the system is in standby mode: proceed with step 3. 
• If the system is shut down completely: start with step 1. 

NOTE  

If you want to restart the system immediately after putting it to standby mode, wait 30 
seconds after switching the power supply switch to the 0 position. 

1. Switch on main the power supply by turning the main switch to the ON position. 
2. Turn the interlock key switch 90° clockwise. 
3. Switch the power supply switch at the rear of the machine to the I position 
 The power LED lights up. 
4. Make sure that air pressure for the stage is applied and that the cover lid is closed. 
 The interlock circuit LED does not light up. 
5. Power up the processing unit according to the manufacturer’s instructions.  
6. Start the Exposure Wizard by clicking the shortcut icon on the desktop. 
 For more information, see "4.1 Exposure Wizard: Overview", page 30. 

NOTE  

When starting the wizard after a shutdown, the startup takes approximately a minute 
due to the necessary initialization processes. 

 The camera software starts at the same time as the wizard. 
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NOTE  

Do not close the camera window while the wizard is running. The wizard may crash 
and has to be restarted. 

7. Once the startup sequence is finished, run a stage initialization (Tools » Initialize 
Stage). 

 The system is ready for exposure job setup. 

5.2 Put the system to standby mode 
Perform the following steps to put the system to standby mode: 
1. Terminate the wizard (File » Exit). 
 The wizard is terminated after all background processes are shut down, which takes 

approximately 10 seconds. 
2. Switch the power supply switch at the rear of the machine to the 0 position. 
 The power LED does not light up. 
3. Shut down the user PC according to the manufacturer’s instructions. 
Now, the system is in standby mode. 

5.3 Shut down the system 
NOTE  

In general, the system should only be shut down completely if absolutely necessary. 
Keeping the system in standby mode enhances system stability. 

Perform the following steps to shut down the system: 
1. Put the system to standby mode. 
2. Turn the interlock key switch 90° counterclockwise. 
3. Turn the main switch to the OFF position. 
Now, the system is completely shut down. 

5.4 Shut down the system for service 
Perform the following steps to shut down the system for service: 
1. Shut down the system. 
2. Secure the main switch in the OFF position. 
 The main switch is equipped with holes for a padlock. 

 
Fig. 41: System shutdown – Main switch 
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5.5 Log in 
When the wizard is completely started, the UserLogin dialog box opens. 

 
Fig. 42: User login – UserLogin dialog box 

Perform the following steps to log in: 
1. Select the required user role from the Username drop-down list. 
 The following list shows the standard user roles: 

• Standard: This user role is the default user role when opening the menu. The 
Standard user role does not require a password and can set up and execute 
exposure procedures. 

• Staff: This user role can create resist templates, job templates, and change 
several system settings. 

• Service: This user role is restricted to Heidelberg Instruments Mikrotechnik 
service engineers, who carry out service, maintenance, and repair tasks on the 
system. 

2. Enter your password in the Password field, if required. 
3. Click Login. 
 The UserLogin dialog box closes 
Now, you are logged in with the selected user role. 
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5.6 Change users 
Perform the following steps to change the user role: 
1. Select User » Change User from the menu bar. 
The UserLogin dialog box opens. 
2. Select the required user role from the Username drop-down list. 
 The following list shows the standard user roles: 

• Standard: This user role is the default user role when opening the menu. The 
Standard user role does not require a password and can set up and execute 
exposure procedures. 

• Staff: This user role can create resist templates, job templates, and change 
several system settings. 

• Service: This user role is restricted to Heidelberg Instruments Mikrotechnik 
service engineers, who carry out service, maintenance, and repair tasks on the 
system. 

3. Enter your password in the Password field, if required. 
4. Click Login. 
 The UserLogin dialog box closes 
Now, you are logged in with the selected user role. 
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The µMLA control software provides an exposure wizard to assist in executing 
exposures. The wizard guides you through the process of exposing a substrate step by 
step. The following subchapters build a sequence of actions that have to be executed 
one after the other. To use the wizard efficiently, follow the instructions given in this 
chapter.  
The following figure is a panel map that shows the way through the individual wizard 
panels. 

 
Fig. 43: Exposure Wizard – Panel map 
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6.1 Select job 
1. Double-click the MLA Menu shortcut icon on the desktop to start the Exposure 

Wizard. 
 The Exposure Wizard opens. 
 A new job is created with a job name and a job number. 

2. If you want to change the job name, enter the new job name in the Name field. 
 

 
Fig. 44: Exposure Wizard – Select job 

3. Select the exposure mode from the Exposure Mode drop-down list. 
 You have the following options: 

• Standard: Select this mode to expose a single design for each layer. Overlay 
exposures are possible in this mode. 

• Series: Select this mode to set up an exposure series with varying parameters, 
such as dose and defoc. 

• Draw Mode: Select this mode to create rectangles, circles, or ellipses of 
arbitrary size limited only by the camera field. You can also use this mode to 
create connections between structures or repair imperfections in structures of 
an exposed layer. 

• Inspection: Select this mode to inspect and measure the exposed structure. 
4. If you want to load an existing job, click Load Job. 
5. If you want to repeat a job, for example, to expose another layer, click Restart Job. 
 A new job is created with the same settings but a new job name and job number. 
6. If you want to create a new job after finishing an exposure job, click New Job. 

NOTE  

The job number increments automatically with each job and cannot be changed. 
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Now, the exposure job is selected. 
Continue with the steps below. 

6.2 Select substrate template 
The system offers a list of substrate templates. If the required substrate template is not 
available in the list, users with extended user rights can add new substrate templates. 

 
Fig. 45: Exposure Wizard – Substrate frame 

Perform the following steps to select a substrate template: 
1. Double-click the Substrate Template field in the Substrate frame. 
 The Load Substrate dialog box opens. 
2. Select the substrate size or substrate shape from the list. For example, if you want 

to load a wafer, select automatic_round. 
3. Click Load. 
 The parameters of the selected substrate template are shown in the Substrate 

frame. 
 The Substrate Template field is highlighted in green. 
Now, the substrate template is selected. 
Continue with the steps below. 
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6.3 Load designs 
This section contains information about how to load designs in different exposure 
modes. 
You can only load designs that are already converted. For more information about how 
to convert designs, see "6.4 Convert designs", page 52. 

6.3.1 STANDARD: FIRST EXPOSURE 
1. Double-click the Design field in the Layer frame. 
 The Design list opens. 

 
Fig. 46: Exposure Wizard – Layer frame – First exposure 

2. Select the design that you want to load in the Design list. 
3. Click Load. 

 
Fig. 47: Exposure Wizard – Design list 

 The Design list closes. 

NOTE  

You do not need to load a design if you are using Draw Mode. If you are using Draw 
Mode, skip the following steps. 
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 The design is shown in the Design field in the Layer frame. 
 The Design field in highlighted in green. 
4. If you want to load a resist type, double click the Resist field in the layer frame. 

Then, select the appropriate resist type for your application. 
 The selected resist type is shown in the Resist field. 
 The thickness of the selected resist type is shown in the Thickness field. 
5. If you want to load a template for a set of alignment marks, double-click the Expose 

Crosses field. Then, select a template from the list. 
 The selected alignment marks template is shown in the Expose Crosses field. 
Now, the design is loaded. 
You can continue with loading the substrate. For more information, see "Load 
substrates", page 54. 

6.3.2 STANDARD: ALIGNMENT 
For aligned exposures, Layer 2 is the first layer for that you can choose a design. On 
Layer 1, the alignment marks are exposed. 
1. Double-click the Design field in Layer 2 in the Layer frame. 
 The Design list opens. 

 
Fig. 48: Exposure Wizard – Layer frame - Alignment 

2. Select the design that you want to load in the Design list. 
3. Click Load. 
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Fig. 49: Exposure Wizard – Design list - Alignment 

 The Design list closes. 
 The design is shown in the Design field in the Layer frame. 
 The Design field in highlighted in green. 
4. Double-click the Align Crosses field. 
 The alignment mark templates list opens. 
5. Select the alignment marks template that you want to use. 
 A special template called _Manual.xml is offered for cases in which the alignment 

mark positions should be selected in the alignment setup. The exposure is then 
executed with the manually selected alignment positions which are saved 
afterwards as [jobname]_AlignPos_L[No. of layer] (see below). 

 Additionally, if a different template was selected, alignment positions can be 
changed or even ignored. For more information, see "6.7 Set up overlay alignment", 
page 60. 

 
Fig. 50: Exposure Wizard – Alignment mark templates 

6. Click Load. 
 The alignment mark templates list closes. 
 The design is shown in the Alignment Crosses field in the Layer frame. 
 The Alignment Crosses field in highlighted in green. 
7. If you want to load a resist type, double click the Resist field in the layer frame. 

Then, select the appropriate resist type for your application. 
 The selected resist type is shown in the Resist field. 
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 The thickness of the selected resist type is shown in the Thickness field. 
Now, the design is loaded. 

NOTE  

If the first layer does already exist on the substrate, it can be easily skipped. 

You can continue with loading the substrate. For more information, see "6.5 Load 
substrates", page 54. 

6.3.3 SERIES 
In the Series exposure mode, the template and design files are selected automatically 
when selecting Series from the Exposure Mode drop-down list. For more information, 
see "6.1 Select job", page 47. 
The Layer frame turns into the Series frame with different parameters than displayed in 
the Layer frame. 

 
Fig. 51: Exposure Wizard – Series frame 

If you need a different design file for your series exposure, load a new design. For more 
information, see "6.3.1 Standard: First exposure", page 49. 

6.4 Convert designs 
This section contains information about how to convert a design. 
If you loaded an already converted design from the Design list, skip the following steps. 
Perform the following steps to convert a design: 
1. Double-click the Design field in the Layer frame. 
 The Design list opens. 

 
Fig. 52: Exposure Wizard – Layer frame – First exposure 
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2. Click Convert Design. 
 The conversion software window opens. 

 
Fig. 53: Exposure Wizard – Design list 

3. Select File » New Job in the menu bar. 

 
Fig. 54: Conversion software window – Convert design 

4. Enter the job name. 
5. Click OK. 
6. Click Add. Then, select a design format. 
 A directory opens that contains the source files for the selected design format. 
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NOTE  

To load a design from an external storage media into the corresponding HIMT folder, 
copy the external design file to the directory HIMT\Designs\<design type>. 

7. Select the file that you want to convert into the LIC file format. 
8. If necessary, change settings and/or use the viewer application. 
 For more information, see the Conversion Job Manager. 
9. Click Complete Tasks to save the conversion job settings and proceed to the 

expose job setup. 
10. Click Finish in the dialog box. 
 The conversion software window closes. 
11. Click Refresh in the Design list. 
Now, the converted design is shown in the Design list and can be loaded. For more 
information about how to load a design, see "6.3 Load designs", page 49. 

6.5 Load substrates 
NOTICE  

Observe the general guidelines for handling substrates. 
• Do not expose the substrate to white light. 
• Do not touch the surface on areas that are to be exposed. 
• Avoid scratches on both the upper and lower surface. 
• Make sure that both the stage and the substrate are clean. 

Perform the following steps to load the substrate: 
1. Click Load Substrate to move the stage into the loading position. 

 
Fig. 55: Set Up Job panel – Load Substrate 

2. Make sure that the white light is switched off. 
 Only the appropriate safelight is switched on. 
3. Take the substrate out of the container. 
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4. Open the cover lid. 
5. Carefully place the substrate correctly oriented on the stage. 
 You can use alignment pins to orient the substrate correctly. For more information 

about how to position alignment pins, see "3.9.1 Position alignment pins", page 28. 
6. Switch on the vacuum with the vacuum switch. 
7. Make sure that the substrate is held firmly in place. 
 When you gently try to push the substrate sideways, the substrate does not move. 
 Troubleshooting if the substrate moves: 

• Check the stage and the substrate for dirt. 
• Check the substrate for scratches. 
• Try using a different substrate. 
• Try increasing the ejector flow. 
 For more information, see "10.4 Adjust the ejector flow", page 92. 

 Troubleshooting if the substrate is too small and vacuum holes remain open: 
• Make sure that you have chosen the correct substrate size for the application. 
• Deactivate the surrounding vacuum zones via the vacuum zone selection 

screws. 
 For more information, see "3.8 Activate/deactivate vacuum zones", page 27. 
• Try to cover the remaining vacuum holes, for example, with thick foil. 

8. If you used alignment pins, make sure that all alignment pins are removed from the 
stage. For more information about how to remove alignment pins, see "3.9.2 
Remove alignment pins", page 28. 

9. Close the cover lid. 
10. Make sure the interlock lamp is off. 
 The system searches for the center of the substrate and provides information about 

the progress via a message box. 
 If you wish to abort the Find Plate Center procedure, click Stop in the message box 

and start the loading process again. 
Now, the substrate is loaded. 
Continue with one of the following steps: 
• In Standard Mode with overlay alignment, the Alignment panel opens. 
 Continue with settings up an overlay alignment exposure. For more information, see 

"6.7 Set up overlay alignment", page 60. 
• In Standard Mode without overlay alignment, the Exposure panel opens. 
 Continue with the first exposure. For more information, see "6.8.1 First Exposure 

procedure", page 63. 
• In Series Mode, the Series panel opens. 
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 Continue with a series exposure. For more information, see "6.8.3 Exposure Series 
procedure", page 66. 

6.6 Draw structures 
This chapter explains how to draw structures in Draw Mode. 
In the Procedure frame of the Draw Mode panel, select the shape that you want to 
draw. 

 
Fig. 56: Draw Mode panel – Procedure frame 

 

Object Description 
Draw Image Select this option to use the shapes that are offered in the camera 

window: 
• Rectangle 
• Ellipse 
• Circle 
• Bitmap file 

Draw Line or 
Polygon 

Select this option to draw lines or polygons (lines with more than two 
points). 
You can set the line width in the Line width field. 

Expose Crosses Select this option to expose crosses for alignment orientation without 
the design (in Standard Mode a design has to be loaded). In the 
Expose Crosses table, you can load the bitmap file for cross exposure. 

Tab. 13: Procedure frame – Control objects 
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6.6.1 DRAW IMAGE 
Perform the following steps to draw images: 
1. Select Draw Image in the Procedure frame of the Draw Mode panel. 
2. Select the area in that you want to draw the image in the Camera window. 
 You can use the controls in the Stage and Camera Control frame to move the 

camera image. 
3. Select the shape that you want to draw in the Camera window. 
 

 
Fig. 57: Draw Mode panel – Draw images 

4. Move the image to the desired position. 
 You have the following options: 

• You can drag and drop the image to the desired position. 
• You can rotate the image by clicking the green dot. Then, you can drag the 

green dot to rotate the image. 
5. If you want to save the image, click Save. 

NOTE  

You can also load a bitmap file by clicking Load and selecting the file. To directly load 
a bitmap file click BMP located below the structure icons. 
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Fig. 58: Draw Mode panel – Save images 

6. If you want to clear the image, click Clear in the menu bar of the Camera window. 
7. Click Submit in the menu bar of the Camera window. 
Now, the image is submitted. 
You have the following options: 
• You can draw more structures. 
• You can start the exposure procedure. For more information, see "6.8.4 Draw Mode 

exposure procedure", page 68. 

6.6.2 DRAW LINE OR POLYGON 
Perform the following steps to draw lines or polygons: 
1. Select Draw Line or Polygon in the Procedure frame of the Draw Mode panel. 
2. Move the camera to the position where you want to set the first point of the line or 

polygon. 
 You can use the controls in the Stage and Camera Control frame to move the 

camera image. 
3. Click Set Point. 
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Fig. 59: Draw Mode panel – Draw Line or Polygon 

 A crosshair appears in the Camera window. 
4. Left-click on the position where you want to set the first point of the line or polygon. 

 
Fig. 60: Draw lines or polygons – Set point 

5. Move to the next point of the line/polygon by using the arrow buttons of the Control 
Panel.  

6. Click Set Point and repeat the set point procedure. 
7. Click Accept line. 
8. To draw a polygon, go on with the set point procedure and click Accept Polygon to 

submit the polygon drawing. 
Now, the line or polygon is submitted. 
You have the following options: 
• You can draw more structures. 
• You can start the exposure procedure. For more information, see "6.8.4 Draw Mode 

exposure procedure", page 68. 

6.6.3 EXPOSE CROSSES IN DRAW MODE 
Perform the following steps to expose alignment crosses in Draw Mode: 
1. Select Expose Crosses in the Procedure frame of the Draw Mode panel. 
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Fig. 61: Draw Mode panel – Expose Crosses 

2. If not selected in the Setup panel, a bitmap file must be selected for every cross 
position: 
1. Click Edit and select a template for every cross position. To select the same file 

for every position, select the Use first bitmap for all checkbox. 
2. Enter the positions into the table. 
3. Click Edit again, to leave the editing mode. 

Now, the alignment cross positions are set. 
Continue with the exposure procedure. For more information, see "6.8.4 Draw Mode 
exposure procedure", page 68. 

6.7 Set up overlay alignment 
This section explains how to set up and execute an overlay alignment exposure. If you 
do not want to set up an overlay alignment, skip the following steps. 
With the µMLA, you can execute precise alignment exposures to achieve the best 
results. For using the available alignment modes, choose standard exposure mode in 
the Setup Job panel. 
The alignment function offers the following alignment modes: 
• Cross Alignment: Use this mode to automatically detect alignment crosses. It is 

recommended to use Cross Alignment mode. 
• Manual Alignment: Use this mode to manually detect alignment crosses if 

automatic cross detection fails. 

NOTE  

Click Edit to change the template that was selected in the Setup panel. 
To restore the original alignment cross positions from the selected file, click Original. 
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6.7.1 SET UP PARAMETERS 

 
Fig. 62: Exposure Wizard – Overlay Alignment 

Perform the following steps to execute an overlay alignment procedure: 
1. Select the high-resolution camera in the Camera Control frame. 
2. Select the alignment mode from the Alignment Mode drop-down list in the Cross 

Measurement frame. 
 You can select a different alignment mode for each alignment cross position. 
3. Check the alignment cross positions in the Alignment Cross Positions frame. 
4. If you want to edit alignment cross positions, perform the following steps: 

1. Select the relevant alignment cross position from the list in the Alignment Cross 
Positions frame. 

2. Click Edit. 
3. Enter the x-coordinate and y-coordinate of the new position. 
 To delete one of the coordinates, delete the value and leave the field blank. If, 

for instance, you intend to skip the second cross position in the list, delete the 
value, copy the value from the third cross position field into it. Leave the third 
position field blank. 

4. Click Save. 
 The positions are stored in a temporary file. After the exposure process starts, 

the temporary file is saved as a template. 
5. Perform step 1 to steps 3 for each alignment cross position that you want to 

edit. 
6. If you want to restore the original alignment cross positions, click Original. 
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 If you selected the template _Manual.xml was selected, all alignment cross 
positions have to be set manually via the edit function. 

 The alignment cross positions are edited. 
Now, the parameters are setup up. 
Continue with the steps below. 

6.7.2 EXECUTE MEASUREMENT 
Perform the following step to execute measurements: 
1. Move the camera to the first alignment cross. 
 You use the stage and camera controls in the Control Panel to move the camera. 

For more information, see "7.1 Control panel", page 71. 

2. If you use Cross Alignment mode, perform the following steps: 
1. Click Measure. 

 The system measures the position of the alignment cross. 
 The system moves the alignment cross into the center of the camera window. 

2. Check the position of the alignment cross. 
3. Click Accept position. 

 In the Pos column in the Alignment Cross Positions frame, a tick mark indicates 
that the relevant position was accepted. 

 The procedure continues with the next alignment cross. 
4. Perform step 1 to step 3 for all alignment crosses that you want to measure. 

 All alignment crosses are measured. 
3. If you use Manual Alignment mode, perform the following steps: 

1. Click Measure. 
 In the camera window, a crosshair is shown. 

2. Move the crosshair to the alignment cross position that you want to set. 
3. Left-click to set the alignment cross position. 

 The crosshair turns from green to orange. 

NOTE  

For fine positioning use the arrow buttons. You can switch between continuous 
movement (jogging) and stepwise movement. 
In step mode enter the step size [µm] for X and Y direction into the corresponding 
fields. 
In the jogging mode, change the driving speed [µm/s] either by using the slider or by 
clicking into the corresponding field and entering the speed manually. Alternatively, 
click into the slider field and use the arrow keys for setting the speed. 
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4. Perform step 1 to step 3 for all alignment crosses that you want to measure. 
 All alignment crosses are measured. 
4. If you want to center an alignment cross position in the camera window, click 

Center Cross. 
5. If you want to skip an alignment cross position, click Skip Position. 
 The relevant alignment cross position is skipped. 
 In the Pos column in the Alignment Cross Positions frame, a red cross indicates 

that the relevant position was skipped. 
6. Click Continue. 
 The Alignment: Exposure panel opens. 
Continue with the overlay alignment exposure. For more information, see "6.8.2 Overlay 
Exposure procedure", page 65. 

6.8 Expose designs 
This section explains how to execute exposures in different exposure modes. 
The system offers two standard exposure modes, one with and the other one without 
overlay alignment. Additionally, it is possible to execute series exposures in order to 
determine the appropriate defoc settings and dose settings for the current exposure job. 
In Draw Mode you skipped the design loading and created your own structures directly 
on the substrate inside the camera window. 

6.8.1 FIRST EXPOSURE PROCEDURE 
You start the First Exposure procedure in the First Exposure panel. 
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Fig. 63: Exposure Wizard – First Exposure 

Perform the following steps to start the First Exposure procedure: 
1. Check the design name in the Required frame. 
2. Enter the dose value in the Dose field. 
3. Enter the defoc value in the Defoc field. 
4. If you want to automatically unload the substrate after the exposure procedure is 

complete, select the Auto-Unload checkbox. 
5. If you want to expose alignment crosses, select the Expose the crosses checkbox. 
 For more information about how to select an alignment cross positions template, 

see "6.3.1 Standard: First exposure", page 49. 
–  If you want to edit the alignment cross positions, click Edit. 
– If you want to restore the original alignment cross positions, click Original. 

6. Click Start Exposure. 
 The exposure procedure starts. 

NOTE  

If the process requires your decision, the process is put on hold and a dialog box 
opens. 
Read the message in the dialog box carefully. Then, decide to accept or reject. 

When the exposure procedure is complete, you can continue with unloading the 
substrate. 
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6.8.2 OVERLAY EXPOSURE PROCEDURE 
You start the Overlay Exposure procedure in the Alignment Exposure panel. 

 
Fig. 64: Exposure Wizard – Alignment Exposure 

Perform the following steps to start the Overlay Exposure procedure: 
1. Check the design name in the Required frame. 
2. Enter the dose value in the Dose field. 
3. Enter the defoc value in the Defoc field. 
4. Check the alignment cross positions in the Expose Cross positions frame. 
5. If you want to automatically unload the substrate after the exposure procedure is 

complete, select the Auto-Unload checkbox. 
6. Click Start Exposure. 
 The exposure procedure starts. 

NOTE  

If the process requires your decision, the process is put on hold and a dialog box 
opens. 
Read the message in the dialog box carefully. Then, decide to accept or reject. 

When the exposure procedure is complete, you can continue with unloading the 
substrate. 
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6.8.3 EXPOSURE SERIES PROCEDURE 
You start the Exposure Series procedure in the Series panel. 

 
Fig. 65: Exposure Wizard – Exposure Series 

Perform the following steps to start the Exposure Series procedure: 
1. Check the design name in the Required frame. 
2. Select the exposure series mode from the Mode field in the Parameters frame. 

 
Fig. 66: Exposure Series – Parameters frame 
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 You have the following options: 
1. Select Dose to start a dose series with incrementing dose values. 
– Set the number of fields that you want to expose in the Number of Fields field. 
– Set the starting dose value in the Start Value field. 
– Set the step size for the dose value in the Step Size field. 
 Note that the defoc value cannot be changed when executing a dose series 

exposure. 
2. Select Defoc to start a defoc series with incrementing defoc values. 
– Set the number of fields that you want to expose in the Number of Fields field. 
– Set the starting defoc value in the Start Value field. 
– Set the step size for the defoc value in the Step Size field. 
 Note that the dose value cannot be changed when executing a defoc series 

exposure. 
3. Select Dose and Defoc to start a dose and defoc series with incrementing dose 

and defoc values. 
– Set the number of fields that you want to expose in the Number of Fields field. 
– Set the starting dose value in the Start Value field. 
– Set the step size for the dose value in the Step Size field. 
– Set the starting defoc value in the Start Value field. 
– Set the step size for the defoc value in the Step Size field. 

3. Set the Step size in x- and y-direction table at the bottom of the Parameters frame. 
 You can also set the number of rows for dose exposure series or defoc exposure 

series. Note that this is not possible for dose and defoc exposure series. 
4. If you want to write the parameters dose and defoc in plain text below the exposed 

field on the wafer, select the Expose Labeling checkbox. This does not increase 
the exposure time. 

 
Fig. 67: Exposure Series – Expose Labeling 
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 Note that the step size has to be increased so that the label fits below each field. 
The Step Size field is highlighted in orange if the step size is too low. With labeling 
exposure activated, the Total Range is increased. 

5. If you want to automatically unload the substrate after the exposure procedure is 
complete, select the Auto-Unload checkbox. 

6. Click Start Exposure. 
 The exposure procedure starts. 

NOTE  

If the process requires your decision, the process is put on hold and a dialog box 
opens. 
Read the message in the dialog box carefully. Then, decide to accept or reject. 

When the exposure procedure is complete, you can continue with unloading the 
substrate. 

6.8.4 DRAW MODE EXPOSURE PROCEDURE 
You start the Draw Mode Exposure procedure in the Draw Mode panel. 

 
Fig. 68: Exposure Wizard – Draw Mode Exposure 

Perform the following steps to start the Draw Mode Exposure procedure: 
1. Enter the dose value in the Dose field. 
2. Enter the defoc value in the Defoc field. 
3. If you want to automatically unload the substrate after the exposure procedure is 

complete, select the Auto-Unload checkbox. 
4. Click Start Exposure. 
 The exposure procedure starts. 
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NOTE  

If the process requires your decision, the process is put on hold and a dialog box 
opens. 
Read the message in the dialog box carefully. Then, decide to accept or reject. 

When the exposure procedure is complete, you can continue with unloading the 
substrate. 

6.9 Unload substrates 

6.9.1 UNLOAD SUBSTRATES AUTOMATICALLY 
The system provides the option to unload the substrate automatically in various 
contexts by selecting the Auto-Unload checkbox. 

 
Fig. 69: Exposure Wizard – Auto-Unload checkbox 

Above, possible locations of the Auto-Unload checkbox are shown. Depending on the 
exposure mode, the checkbox can be located below the info box or below the 
parameter setup frames. You can select the Auto-Unload checkbox before starting the 
exposure procedure. 
If the Auto-Unload checkbox is selected, the system automatically moves the stage into 
the unloading position directly after the exposure process is finished. After the unloading 
procedure is finished, the wizard directly leads you back to the Setup Job panel where 
you can start a new job with New Job. You can take the substrate from the chuck or 
leave it there for exposing a further layer. 
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6.9.2 UNLOAD SUBSTRATES MANUALLY 
If you do not want to unload the substrate automatically, you can unload the substrate 
manually. 
After an exposure procedure is finished, the Exposure Finished dialog box opens. 

 
Fig. 70: Exposure Wizard – Exposure Finished dialog box 

You have the following options: 
• If you want to unload the substrate, click Yes. Then, remove the substrate from the 

chuck. 
• If you do not want to unload the substrate, click No. 
Alternatively, you can click Unload Substrate in the Proceed frame at the bottom of the 
Setup Job panel. 

6.9.3 REMOVE SUBSTRATES FROM THE CHUCK 
NOTICE  

Observe the general guidelines for handling substrates. 
• Do not expose the substrate to white light. 
• Do not touch the surface on areas that are to be exposed. 
• Avoid scratches on both the upper and lower surface. 
• Make sure that the stage and the substrate remain clean. 

Perform the following steps to remove the substrate from the chuck: 
1. Make sure that the white light is switched off. 
 Only the appropriate safelight is switched on. 
2. Open the cover lid. 
3. Carefully take the substrate off the chuck and stow it in an opaque box impermeable 

to light. 
4. Close the cover lid. 
5. Click OK in the Exposure Wizard, if necessary. 
 The unloading dialog box closes. 
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The µMLA control software offers further elements besides the main menu that facilitate 
handling the exposure and alignment processes. 

7.1 Control panel 
The Control Panel provides navigation functions as well as other necessary control 
functions. 

7.1.1 CAMERA CONTROL FRAME 
In the Camera Control frame, you can select the available cameras by clicking the 
corresponding camera button. The information about the field of view of the different 
cameras helps to make the decision which one to choose for the current application. For 
alignments, it is recommended to use the High-Resolution camera as its high resolution 
is best for alignment procedures. 

 
Fig. 71: Control panel – Camera Control frame 

The following table shows the field of view dimensions of the cameras for the different 
write modes: 
Camera Write Mode I Write Mode II 

High-Resolution camera 150 µm × 110 µm 384 µm × 288 µm 

Overview camera 13 mm × 10 mm 13 mm × 10 mm 

Tab. 14: Camera – Field of view dimensions 

Below the camera buttons, you find the Focus slider for setting the camera focus and 
the Brightness slider for setting the brightness of the camera image. 

 
Fig. 72: Control panel – Sliders 

In Alignment Mode, for very thick resists the focus can be switched to a larger camera 
defocus with a wider defocus range by selecting Tools » Large Camera Defoc from the 
menu bar. Moving the Range slider changes the focus position in a wider range. 



µMLA    
 

 
 

 

72 User Manual 

 
Fig. 73: Control panel – Sliders – Large Camera Defoc 

Click on the slider and keep the mouse button held down while moving it to the desired 
value on the slider bar. Alternatively, click on the slider bar and use the cursor keys for 
moving the slider along the bar. The tick marks on the focus slider bar are for your 
orientation within the range from -10 to +10 so the center tick mark sets the focus to 0. 

7.1.2 STAGE CONTROL FRAME 
The Stage Control frame provides arrow buttons to move the stage. Every click is one 
movement. They are also used for fine positioning. 

 
Fig. 74: Control panel – Stage Control frame 

 

Object Description 
Driving Speed Select continuous stage movement (jog mode). 

X/Y Step Select stepwise stage movement (step mode). 

Move To Zero Move the stage to the (0/0) position. 

Substrate Center Move to the stage to the substrate center. 

 

Control the stage movement via the arrow buttons. 

Set Zero Set the current position as the (0/0) position. 

Stop Stop any stage movement. 

Tab. 15: Stage Control frame – Control objects 
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The control software offers 2 stage movement modes: 
• Continuous movement (jog mode) 
• Stepwise movement (step mode) 

JOG MODE 
In jog mode, you can enter the movement speed in the Drive Speed field. Alternatively, 
you can use the slider to set the movement speed. 

 
Fig. 75: Control panel – Stage Control frame – Jog mode 

STEP MODE 
In step mode, enter the step size [µm] for X and Y direction. The arrow buttons for 
navigation on the substrate surface change their appearance according to the selected 
mode. This contributes to fast identification of the mode currently selected. 

 
Fig. 76: Control panel – Stage Control frame – Step mode 
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7.2 Optimize alignment and exposure results 

7.2.1 OPTIMIZE ALIGNMENT RESULTS 
Sometimes the measurements during the alignment process might be unsatisfying due 
to bad contrast caused by uneven surface conditions or low reflectivity of the substrate. 
This chapter gives advice on how to improve the measurement results during the 
alignment process. 

REPEAT THE MEASUREMENT 
After the first measurement procedure for a coordinate point is complete, the 
Re-Measure button is shown instead of the Measure button. 
You can click Re-Measure to repeat the measurement procedure. Repeating the 
measurement procedure can lead to better results. 

CHANGE THE SIZE OF THE DETECTION AREA 
For the finding cross function to work properly, it is important that the alignment cross 
fills the entire camera window. If this is not the case, click ResizeDetectionArea. Inside 
the camera window, a rectangle appears showing the new detection area. To enlarge 
the detection area, click the right bottom corner of the rectangle without releasing the 
mouse button and drag the corner to the desired size while holding down the mouse 
button. To maximize the detection area again, click MaximizeDetectionArea. 

ADJUST SETTINGS IN THE CONTROL PANEL 
• Adjust the values for focus or brightness to make the finding cross function work 

more efficiently. 
• Select a different camera to get a better view of the substrate. 
• In the Stage Control panel, switch between Jog mode and Step mode. 

SWITCH TO MANUAL MODE 
For each alignment cross, it is possible to switch between the two modes for the 
alignment procedure. Manual Alignment is the manual mode for cross detection and is 
provided for exceptional cases in which the automatic detection might not work properly. 
For more information about how to use the Manual Alignment mode, see "6.7 Set up 
overlay alignment", page 60. 

7.2.2 OPTIMIZE EXPOSURE RESULTS 
Sometimes exposure results can be unsatisfying for the needs of distinctive 
applications. The system offers a way of optimizing the exposure results. It is possible 
to adjust the defoc value or the dose value. The following contains information about 
how to work with these two values to improve exposure results. 
The Exposure Wizard offers a series exposure mode. You can use the Series Exposure 
mode to optimize exposure results by adjusting the defocus value (defoc) and/or the 
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energy value (dose). You can execute an exposure series to determine the best ratio 
between these two parameters. 

 
Fig. 77: Exposure Wizard – Exposure Series 

For more information about the Exposure Series procedure, see "6.8.3 Exposure Series 
procedure", page 66. 
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This chapter explains wizard functions that require extended user rights and are only 
available for the Staff user role. 

8.1 System backup 
This chapter explains how to back up the system files. You can access the System 
Backup window via Select Tools » Backup in the menu bar. 

 
Fig. 78: Advanced functions – System backup 

 

Object Description 
Change Directory Change the directory for saving the backup files. 

Basic Select all basic backup options. 

Extended Select all extended backup options. 
Note that the extended backup options require a high memory 
capacity. 

Backup Menu Select this option to back up the Menu software, including binaries and 
configuration files. 

Backup SharkVision Select this option to back up the files of the camera software including 
binaries and configuration files. 
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Backup SSH Select this option to back up the user credentials the menu uses to 
communicate with the Linux in the VirtualBox. 

Backup VirtualBox Select this option to back up various configuration files of the 
VirtualBox. 

Backup Conversion Select this option to back up the conversion software binaries of Linux, 
including binaries and configuration files. 

Backup SPiiPlus Select this option to back up the motion controller configuration and 
program buffers. 

Backup Light 
Sources 

Select this option to back up the light source configuration. 

Backup Stepper 
Motors 

Select this option to back up the current positions of all stepper 
motors. 

Backup Autofocus 
Board 

Select this option to back up various configuration files of the 
Autofocus Card. 

Backup Log Files Select this option to back up all log files created by the control 
software, including Common Log and Job Exposure Logs. 

Backup Designs & 
Labels 

Select this option to back up the design files located in 
C:\HIMT\Designs. 
Note that a backup of the design files may require a large amount of 
disk space, depending on the design size. 

Tab. 16: System backup – Control objects 
 
 

8.2 Execute LED measurements 
This section explains how to measure the LED power. You measure LED power to 
compare it with the value measured during the most recent calibration procedure. 

PRECONDITIONS 
Before starting the LED measurement procedure, complete the following tasks: 
• Switch off the vacuum. 
• Make sure that the stage is empty. 

PROCEDURE 
Perform the following steps to execute LED measurements: 
1. Select Tools » LED Measurement from the menu bar. 

NOTE  

We recommend copying the backup files from the processing unit to an external 
storage media to prevent data loss in the unlikely case of a total failure of the 
processing unit. 
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 The LED Measurement panel opens. 
2. Select the wavelength of the exposure light source from the Light Source drop-

down list. 

 
Fig. 79: Advanced functions – LED Measurement panel 

3. Enter the number of measurements that you want to execute in the Measurements 
field. 

4. Enter the interval between measurements in the Interval field. The interval is 
specified in seconds. 

5. Click Continue. 
6. Check the measurement parameters. 
7. Click Measure. 
 The system executes the measurement. 
 The results of each measurement are shown in the Intensity Measurements list next 

to the info box. 
 The average results are shown in the Results frame in the LED Measurement 

panel. 

 
Fig. 80: LED Measurement panel – Results 

Now, the LED measurement procedure is complete. 
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You can continue with the following actions: 
• To finish the LED measurement procedure, click Finish. 
• To repeat the LED measurement procedure, click Restart. 

8.3 Set up substrate template 
This chapter explains how to set up substrate templates in the Load Substrate panel. 

8.3.1 LOAD SUBSTRATE PANEL 
The Load Substrate panel opens when you click a field in the Substrate Template 
column in the Setup Job panel. 

 
Fig. 81: Setup Job Panel – Substrate Template column 

BASIC OPTIONS 

 
Fig. 82: Load Substrate panel – Basic options 

 

Object Description 
Name Enter a name for the substrate template. 

Shape Select the substrate shape. 
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Small There are 3 substrate size categories: 
• Small (5-9 mm) 
• Standard (10-180 mm) 
• Extended (181-230 mm) 
The value is set automatically when you enter the substrate size in the 
Size X and Size Y fields. 

Size X Enter the substrate size in x-direction. 

Size Y Enter the substrate size in y-direction. 

Diameter Enter the diameter of the wafer. 

Thickness Enter the thickness of the substrate. 

Detection Offset Due to a machine offset the size of the substrate entered might differ 
from the size measured by the system during the loading process. 

New Create a new substrate template. 

Edit Edit the selected existing substrate template. 

Save Save the substrate template. 

Delete Delete the selected substrate template. 

Tab. 17: Load Substrate panel – Basic options – Control objects 

ADVANCED OPTIONS 

 
Fig. 83: Load Substrate panel – Advanced options 

 

Object Description 
Autofocus Mode Select the autofocus mode from the drop-down list. 

Check With 
Overview Camera 

Select this option to check the substrate with the overview camera 
before focusing (same procedure as loading small substrates). 

Skip Find Plate 
Center 

Select this option to skip the find plate center procedure. 

NOTICE  

Increased risk of nozzle crash 
Without executing the find plate center procedure a stable 
focus throughout the entire surface cannot be guaranteed, 
which increases the risk of a nozzle crash. 
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Use this option only for special applications after contacting 
your local Heidelberg Instruments Mikrotechnik Customer 
Service Center. 

 

Focus Offset X/Y Set the focus offset in x- and y-direction. 

NOTICE  

Increased risk of nozzle crash 
When using the focus offset function keep in mind that the risk 
of nozzle crash is increased. Check the offset twice before 
execution. 

 

Focus Offset Z Set the focus offset in z-direction. 

NOTICE  

Increased risk of nozzle crash 
When using the focus offset function keep in mind that the risk 
of nozzle crash is increased. Check the offset twice before 
execution. 
Use this option only for special applications after contacting 
your local Heidelberg Instruments Mikrotechnik Customer 
Service Center. 

 

Max Velocity Reduce the travel velocity of the stage. Some applications may require 
a reduced travel velocity 

Regular Use AF Air 
Pressure 

Activates or deactivates the compressed air for the pneumatic 
autofocus: 
• Selected: The compressed air for the pneumatic autofocus is 

switched on. 
• Deselected: The compressed air for the pneumatic autofocus is 

switched off. 

Tab. 18: Load Substrate panel – Advanced options – Control objects 

8.3.2 SET UP TEMPLATE 
1. Click a field in the Substrate Template column in the Setup Job panel. 
 The Load Substrate panel opens. 
2. Click New in the Edit frame. 
3. Set the substrate parameters in the Characteristics frame. 
4. Set the advanced substrate parameters in the Advanced Parameters frame, if 

required. 
5. Click Save in the Edit frame. 
 The new substrate template is created. 
 The new substrate template can be used by other users. 
6. Start a loading procedure and select the new template in the Substrate frame. 
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7. Load the substrate. 
 During the loading procedure, the system measures the substrate size. 
 The Find Plate Center dialog box opens and notifies you about the detected 

substrate size and possible deviations from the size set in the table. 
Now, the procedure is finished. 
You have the following options: 
• Click Yes to continue. 
 You can continue even if a deviation occurred. 
• Click No to stop the procedure if a deviation occurred. 
 You return to the Load Substrate panel and adjust the detection offset in the 

Characteristics frame. 

8.4 Set up resist templates 
This chapter explains how to set up resist templates in the Load Resist panel. 

8.4.1 LOAD RESIST PANEL 
The Load Resist panel opens when you click a field in the Resist column in the Setup 
Job panel. 

 
Fig. 84: Advanced functions – Load Resist panel 

 

Object Description 
Name Enter a name for the resist template. 

Resist Enter the resist type. 

Thickness Enter the thickness of the resist. 

Wavelength Select the exposure light sources for which the resist is available. 

Dose Enter the dose that is used for exposing the resist. 

Speedup Factor Enter the speedup factor. 
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At a speedup factor higher than 1, the stage moves faster. This saves 
exposure time when using high doses but reduces the exposure 
quality. If exposure quality is crucial, do not set a speedup factor 
higher than 1. 

Defoc Range Choose between Standard (-10 to 10) and Extended (-25 to 25). 
For more information about exposures with extended defocus range, 
see "8.4.3 Exposing with extended defocus range", page 84. 

Developer Enter the developer name. 

Concentration Enter the concentration. 

Develop Time Enter the development time. 

New Create a new resist template. 

Edit Edit the selected resist template. 

Save Save the resist template. 

Delete Delete the selected resist template. 

Tab. 19: Load Resist panel – Control objects 

8.4.2 SET UP TEMPLATE 
Perform the following steps to set up a resist template: 
1. Click a field in the Resist column in the Setup Job panel. 
 The Load Resist panel opens. 
2. Click New in the Edit frame. 
3. Set the resist parameters in the Characteristics frame. 
4. If you want to change the speedup factor, enter the new speedup factor in the 

Speedup Factor field. 
5. Select Standard from the Defoc Range drop-down list. 
6. Set the process parameters in the Process Parameters frame, if required. 
7. Click Save in the Edit frame. 
 The new resist template is created. 
Now, the new resist template can be used by other users. 
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8.4.3 EXPOSING WITH EXTENDED DEFOCUS RANGE 
This section explains how to set up resist templates with an extended defocus range. 
You use exposure with an extended defocus range, for example, to expose deeper into 
the resist. 

Perform the following steps to set up a resist template with an extended defocus range: 
1. Click a field in the Resist column in the Setup Job panel. 
 The Load Resist panel opens. 
2. Click New in the Edit frame. 
3. Set the resist parameters in the Characteristics frame. 
4. If you want to change the speedup factor, enter the new speedup factor in the 

Speedup Factor field. 
5. Select Large from the Defoc Range drop down list. 
6. Set the process parameters in the Process Parameters frame, if required. 
7. Click Save in the Edit frame. 
 The new resist template is created. 
Now, the new resist template can be used by other users. 

8.5 Execute beam offset calibration 
 

It is possible to re-calibrate the beam offset. This is important for exposures done 
relative to existing structures (overlay). Displacements lead to a systematic shift in the 
overlay. For this reason, the calibration of the write beam is crucial. 
To determine the offset, two layers are necessary that are brought together by overlay 
alignment. The pattern used for the factory acceptance test to determine alignment 
accuracy is ideal for checking the beam offset. It features a Vernier scale from which the 
user can read off the displacement in both directions (X and Y). 

NOTE  

This function serves for extending the exposure defocus range and is not to be 
confused with the Large Camera Defoc function for extending the camera defocus 
range during alignment. These are two different functions. 

NOTE  

This function is for seasonal drifts. In general, these are below 1 µm. When observing 
huge offsets, please double-check your alignment marks and positions. When in 
doubt, contact your local Heidelberg Instruments Mikrotechnik Customer Service 
Center. 

NOTE  

Use HIMT_uMLA_Camoff_L1 and HIMT_uMLA_Camoff_L1 from the designs list. 
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Each layer contains one part of the Vernier scale in each axis. One layer contains the 
(fixed) ruler and the other one contains the (sliding) secondary scale. 

 
Fig. 85: Vernier scale test pattern 

 

 
Fig. 86: FAT test pattern 

Perform the following steps to execute beam offset calibrations: 
1. Execute an overlay exposure. 
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 For more information about how to execute an overlay procedure, see "6.8.2 
Overlay Exposure procedure", page 65. 

2. After the 2 layers are exposed, check the exposure result either by one of the 
cameras in the system or with a microscope. Inspect the pattern and determine the 
beam offset by reading off the nonius. 

3. Read off the offset from the Vernier scale. 
4. Select Tools » Beam Offset from the menu bar. 
5. Enter the value into the Displacement X and Displacement Y fields. The system 

calculates the absolute beam offset automatically. 

 
Fig. 87: Advanced functions – Beam offset calibration 

6. Click Save. 
 The new beam offset is now included into the system operations. 
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9.1 Functional problems  
Problem  The system does not start; the power indication lamp is off  

Possible Causes • facility power down 
• main fuse blown 

Remedies • check facility power 
• check fuse 

 
Problem  CAD design / LIC file folder cannot be found 

Possible Causes • stored in the wrong directory 
• wrong name chosen 

Remedies • make sure the design is stored in C:\HIMT\designs and the 
name of the LIC target directory complies with the file name rules 
of Linux and Windows (no distinguishing between capitals and 
normal letters) 

 
Problem  Exposure does not start 

Possible Causes • air pressure low 
• lid not closed properly 
• design data directory was renamed, or contents have been 

corrupted 
• software hung up 

Remedies • check air pressure (see system installation instructions on 
required values) 

• check on interlock lamp 
• reconvert design 
• reboot system 

 
Problem  Exposure was interrupted, stage motors are disabled 

Possible Causes • air pressure low 
• lid was opened 
• motor capability to maintain stage speed against vibration/shock 

was exceeded 
• system is not well leveled 
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Remedies • check air pressure (see system installation instructions on 
required values) 

• check on interlock lamp before starting a new exposure 

• reset stage (menu Tools » Initialize Stage) 

• check and improve leveling as described in the system setup 
section 

9.2 Exposure result problems 
Problem  Plate is blank 

Possible Causes • structures too small 
• energy too low 
• developer too old/wrong type/wrong mixture 
• LED off or damaged 

Remedies • check design against design rules and lens resolution 
• try higher energies 
• use fresh developer 
• check if light can be seen in the monitor during exposure 

 
Problem  Plate is completely exposed 

Possible Causes • stray light 
• old materials 

Remedies • check for possible stray light sources and eliminate them 
• use a fresh batch of plates and fresh chemicals 

 
Problem  Some structures are missing 

Possible Causes • structures do not comply with design rules or are too small 
• developer or chrome etch old 
• air bubbles in structures during etching 

Remedies • check design against design rules and lens resolution 
• use fresh chemicals 
• avoid drying of the substrate between developing and etching, or 

water the plate thoroughly before etching 

 
Problem  Design is shifted 

Possible Causes • wrong selection of design origin 
• wrong entry of coordinates during alignment 

Remedies • check design 
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• check wizard entries 

 
Problem  Design looks completely mixed up 

Possible Causes • vacuum off 

Remedies • check vacuum pump and vacuum on stage 

 
Problem  Design stretched or shrunk compared to the previous layer 

Possible Causes • previous layer not exposed with µMLA, coordinate system units 
do not match 

Remedies • shrink or stretch design to compensate 

9.3 Advanced troubleshooting 
Please include the following information when contacting your local Heidelberg 
Instruments Mikrotechnik Customer Service Center: 
• Information on settings of compressed air regulators 
• Any error codes and error descriptions provided by the wizard 
• The wizard version that is shown when clicking About in the Menu bar 
• Screenshots, pictures, or descriptive sketches of the problem, if available 
• If the problem refers to an exposure, create an extended report file by activating the 

create detailed report file option. 
• Send the folder C:\HIMT in archived form (.zip, .rar) to your local Heidelberg 

Instruments Mikrotechnik Customer Service Center. If the file gets too large or 
archiving takes too long, omit the subfolder LICSources. 
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10.1 Clean the system 
The system covers, ventilation grilles, and internal surfaces should be cleaned regularly 
to avoid the transfer of particles onto the substrate. 
• Only use a clean, lint-free cloth to clean system covers, ventilation grilles, and 

internal surfaces. 
• In case of stronger contamination, wet the cloth slightly with lid soap suds. 

NOTICE  

Contaminations can damage the air bearings. 
The base on which the air bearings are traveling can be contaminated with oil or fat, 
for example, due to touching with bare hands. 
If the air bearing base is contaminated with oil or fat, the air bearings can be 
damaged by stuck particles. 
Clean the air bearing base with a clean, lint-free cloth and isopropanol. 

 

10.2 Refill the coolant 
The cooling system needs to be checked every month. In case the coolant level is low, 
refill the reservoir (see spare parts list for reorder details). 
The coolant reservoir is located at the rear of the machine. For more information, see 
"3.2 Rear", page 14. 
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Fig. 88: Check and refill the coolant 

Perform the following steps to refill the coolant: 
1. Open the reservoir by turning and then pulling the cap [A]. 
2. Check the coolant level. 
3. Take the bottle of coolant. 
4. Turn on the coolant pump. 
5. Fill the coolant into the reservoir [B] until a level of approximately 1.5 cm below the 

reservoir rim is reached [C]. 
6. Close the reservoir [D]. 
 The coolant system is ready for use. 

10.3 Level the machine 
The main unit of the machine is mounted on 4 height-adjustable feet. You use the 
height-adjustable feet to level the machine. Leveling the machine is important for the 
proper function of the system and for good exposure results. 
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Fig. 89: Level the machine 

1 19 mm wrench 2 10 mm wrench 

Perform the following steps to level the machine: 
1. Check if the main unit stands firmly on all 4 feet. 
2. Check the leveling with a spirit level. 
3. Take a 19 mm wrench. 
4. Release the countering bolt of the foot that you want to adjust. 
5. Adjust the height of the foot by using a 10 mm wrench. 
6. Repeat step 3 to step 5 for every foot that you want to adjust. 

10.4 Adjust the ejector flow 
If the substrate is not held firmly in place by the chuck vacuum, check the ejector flow. 
You find the ejector pressure regulator with the adjustment screw for the ejector flow at 
the rear of the machine. 
You can turn the adjustment screw to adjust the ejector flow until the substrate is held 
firmly in place by the chuck vacuum. 

 
Fig. 90: Ejector pressure regulator with adjustment screw 

 
 


	1 Introduction
	1.1 About this guide
	1.2 Related documentation

	2 General safety information
	2.1 Intended use
	2.2 Limitations
	2.2.1 System boundaries
	2.2.2 Access restrictions

	2.3 Notation
	2.4 Precautions and safety
	2.4.1 LED safety
	2.4.2 Electrical safety
	2.4.3 Other safety risks during operation
	2.4.4 Interlock and service mode
	2.4.5 Emergency shut-off

	2.5 Safety labels

	3 System
	3.1 Front
	3.2 Rear
	3.3 Left
	3.4 Interior
	3.4.1 Base system
	3.4.2 Stage system
	3.4.3 Optics system

	3.5 Machine control
	3.6 Electronics
	3.6.1 Central control unit
	3.6.2 Stage controller
	3.6.3 Power supply
	3.6.4 System network switch
	3.6.5 Conversion PC
	3.6.6 User PC

	3.7 Software
	3.7.1 Conversion software
	3.7.2 Control software
	3.7.3 TeamViewer software
	3.7.4 AnyDesk software

	3.8 Activate/deactivate vacuum zones
	3.9 Use alignment pins
	3.9.1 Position alignment pins
	3.9.2 Remove alignment pins


	4 Exposure Wizard
	4.1 Exposure Wizard: Overview
	4.1.1 Menu bar
	4.1.2 Tab section
	4.1.3 Info section

	4.2 Tooltips
	4.3 Substrate representation
	4.4 Loading panels
	4.4.1
	4.4.2 Load frame
	4.4.3 Search frame
	4.4.4 Show frame
	4.4.5 Parameters frame
	4.4.6 Edit frame
	4.4.7 Designs list


	5 Turn on/off the system
	5.1 Turn on the system
	5.2 Put the system to standby mode
	5.3 Shut down the system
	5.4 Shut down the system for service
	5.5 Log in
	5.6 Change users

	6 Set up jobs
	6.1 Select job
	6.2 Select substrate template
	6.3 Load designs
	6.3.1 Standard: First exposure
	6.3.2 Standard: Alignment
	6.3.3 Series

	6.4 Convert designs
	6.5 Load substrates
	6.6 Draw structures
	6.6.1 Draw Image
	6.6.2 Draw line or polygon
	6.6.3 Expose crosses in Draw Mode

	6.7 Set up overlay alignment
	6.7.1 Set up parameters
	6.7.2 Execute measurement

	6.8 Expose designs
	6.8.1 First Exposure procedure
	6.8.2 Overlay Exposure procedure
	6.8.3 Exposure Series procedure
	6.8.4 Draw Mode exposure procedure

	6.9 Unload substrates
	6.9.1 Unload substrates automatically
	6.9.2 Unload substrates manually
	6.9.3 Remove substrates from the chuck


	7 Utilities and Tools
	7.1 Control panel
	7.1.1 Camera Control frame
	7.1.2 Stage Control frame

	7.2 Optimize alignment and exposure results
	7.2.1 Optimize alignment results
	7.2.2 Optimize exposure results


	8 Advanced functions for staff users
	8.1 System backup
	8.2 Execute LED measurements
	8.3 Set up substrate template
	8.3.1 Load Substrate panel
	8.3.2 Set up template

	8.4 Set up resist templates
	8.4.1 Load Resist panel
	8.4.2 Set up template
	8.4.3 Exposing with extended defocus range

	8.5 Execute beam offset calibration

	9 Troubleshooting
	9.1 Functional problems
	9.2 Exposure result problems
	9.3 Advanced troubleshooting

	10 Operator maintenance
	10.1 Clean the system
	10.2 Refill the coolant
	10.3 Level the machine
	10.4 Adjust the ejector flow


